
Operator's Guide
Auto PSIM 2.0 (english)

Last update 01/13/2026



Auto PSIM 2.0 (english) – Operator's Guide

– 2

Table of Contents

1 The list of terms used............................................................................................4

2 Operator's Guide. Introduction ............................................................................5
2.1 The purpose and structure of the Guide....................................................................................5

2.2 The purpose of the Auto PSIM system .......................................................................................5

2.3 Recommendations for using the Auto PSIM system .................................................................5

3 Using the Auto PSIM software system..................................................................6
3.1 Starting and closing the system .................................................................................................6

3.2 Working with the Traffic analysis monitor interface object......................................................7
3.2.1 General description of the traffic analysis monitor operation ............................................................................... 7

The Statistics tab....................................................................................................................................................... 7

The Events tab......................................................................................................................................................... 10

3.2.2 Viewing and printing the event information in the traffic analysis monitor window.......................................... 10

3.2.3 Viewing and printing the event statistics in the traffic analysis monitor window............................................... 12

3.3 Using the Vehicle Tracer interface object ................................................................................15
3.3.1 Introduction ............................................................................................................................................................ 15

3.3.2 Viewing the data about passing vehicle ................................................................................................................ 16

3.3.3 Viewing the data about the last identified vehicle ................................................................................................ 17

3.3.4 Viewing the identified vehicles protocol................................................................................................................ 21

3.3.5 Alarms operation..................................................................................................................................................... 23

Manual alarm triggering ......................................................................................................................................... 23

Viewing the alarms protocol................................................................................................................................... 25

Alarm processing..................................................................................................................................................... 27

Hiding the processed events in the protocol......................................................................................................... 29

Viewing the alarm information in the Alarm window ........................................................................................... 29

3.3.6 Adding comments to the events ............................................................................................................................ 31

3.3.7 Printing and exporting the vehicle data ................................................................................................................ 33

3.3.8 Viewing the video archive by event........................................................................................................................ 38

3.3.9 Using filters in the protocols .................................................................................................................................. 39

3.3.10 Viewing the Vehicle Tracer errors........................................................................................................................... 43

3.3.11 Creating the additional Online monitor components........................................................................................... 45

3.3.12 Searching the events in the recognizers databases .............................................................................................. 46

Opening and closing the Event search in the Recognizers DBs window.............................................................. 46



Auto PSIM 2.0 (english) – Operator's Guide

– 3

Configuring the events search................................................................................................................................ 48

Creating a search query .......................................................................................................................................... 55

Viewing, printing and exporting the search results............................................................................................... 69

Previewing and printing the event data ................................................................................................................ 76

Creating the Active tracking database ................................................................................................................... 79

Viewing the video archive by an event................................................................................................................... 82

4 Description of the Auto PSIM user interface ......................................................84
4.1 Description of the interfaces of the Traffic analysis monitor object ......................................84
4.1.1 The interface of the Traffic analysis monitor object ............................................................................................. 84

The Statistics tab..................................................................................................................................................... 84

The Events tab......................................................................................................................................................... 85

The event archive mode from cameras ................................................................................................................. 86

4.1.2 The program for viewing reports of the traffic analysis monitor.......................................................................... 88

4.2 Interface description of the Vehicle Tracer object ..................................................................89
4.2.1 The Events monitor................................................................................................................................................. 89

4.2.2 The Alarm window .................................................................................................................................................. 90

4.2.3 The Online monitor................................................................................................................................................. 92

4.2.4 The Event search in the Recognizers DBs window ................................................................................................ 95

4.2.5 The preview report.................................................................................................................................................. 97



Auto PSIM 2.0 (english) – Operator's Guide

The list of terms used– 4

1.
2.
3.
4.
5.

6.
7.

1 The list of terms used
The Guide – this document.
The system – the Auto PSIM software system.
Server – computer with installed Auto PSIM software package.
Traffic – the flow of vehicles.
Vehicle Tracer – the interface object designed for viewing the recognized LP numbers, the types and speeds 
of vehicles, as well as for searching the LPR database and creating reports for specific time periods.
Traffic Monitor – the interface object designed for monitoring vehicle movement.
fps – frame frequency. Number of video stream frames processed by software per 1 second.
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2 Operator's Guide. Introduction

On page:

The purpose and structure of the Guide
The purpose of the Auto PSIM system
Recommendations for using the Auto PSIM system

2.1 The purpose and structure of the Guide
The Guide is an informational reference designed for users of the Auto PSIM system with Operator access rights 
responded for operation with Auto PSIM software and corresponding interface objects.

The Guide contains the following material:

General description of the Auto PSIM software system.
How to use the Auto PSIM software system.
Description of the user interface of the Auto PSIM system.

2.2 The purpose of the Auto PSIM system
The Auto PSIM software system is designed for automated traffic monitoring and control, and has the following 
functionality:

License plate number recognition.
Centralized events registration and processing, generation of notifications and control commands according 
to flexible algorithms.
Searching matches between the recognized plate number and the numbers in the database connected to 
Auto PSIM.
Creating the photo and video archive.
Determining the overall traffic parameters and the parameters of individual vehicles.
Software scalability.

2.3 Recommendations for using the Auto PSIM system
The Auto PSIM software is installed as an extension to the Axxon PSIM software package.

For proper operation of the Auto PSIM system, please follow these recommendations:

Follow the job description accurately.
Use the system for the intended purpose only.
Do not use the computer with Axxon PSIM installed, to run other software which is not part of the Axxon PSIM
package.
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3 Using the Auto PSIM software system

3.1 Starting and closing the system
Please check the working condition of all hardware components – connections, cameras, etc – prior to starting the 
system.

The system can be started using one of the following methods:

Automatically. The system starts automatically after the operating system boots up.
Manually. To start the system manually, in the Start menu, select Programs -> Axxon PSIM -> Client 
Workstation, or use the corresponding shortcut on the Desktop.

Access to the system can be protected by a password. In this case, enter your password to start the system.

To shut down the system, do the following:

Point the mouse to the upper right corner of the screen, the main control panel will open.
Click the icon on the panel.
Select Shutdown in the menu that opens.

The shut down process will start, the password will be required if set.
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3.2 Working with the Traffic analysis monitor interface object

3.2.1 General description of the traffic analysis monitor operation

•
•

On the page:

The Statistics tab
The Events tab

The Traffic analysis monitor window has two tabs: Statistics and Events.

The Statistics tab
This tab displays the general statistics by the event types, including the number and type of vehicles from the Traffic 
analysis module.

Note.

The system can be set up to forbid the shut down. Then, the Shutdown item is not present in the menu.
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The window contains the Type event, Event columns, as well as all traffic lanes created at the stage of the road 
marking (for more details, see Specifying the road marking settings).

There are three buttons below the window: Print (prints a statistics), Archive (switches to the camera archive), and 
Clear (removes events from the list of the Traffic analysis monitor window).

When you use the Archive button, you can switch to the events archive from a camera, where you can configure the 
period and filters by the detector, by an event, and by the vehicle of this detector.

https://docs.axxonsoft.com/confluence/spaces/AutoPSIM200en/pages/366051899/Specifying+the+road+marking+settings
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Use the Monitoring button if you want to switch to the monitoring mode from the archive viewing mode.
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If you use the Refresh button, the data included in the sample is updated. The OK button is responsible for event 
filtering, and the Cancel button for filter resetting.

You can display the statistics data on the screen or print the Statistics of violations, events and vehicle access
report by using the Print button (for more details, see Viewing and printing the event statistics in the traffic analysis 
monitor window).

The Events tab
This tab displays the list of events received from a camera.

The window contains the Object and Event columns with the RR channel number on which the event is detected.

When you select an event from the list on the right side of the window, the details of this event are displayed: the 
camera name, the lane name, the event name, the date in the DD.MM.YYYY format, and the time of the event 
detection, as well as the photo from a camera that detects an event.

There are two buttons below the window: Clear to remove the information about the selected event from the right 
part of the window and Print to view and print a report by the selected event (for more details, see Viewing and 
printing the event information in the traffic analysis monitor window).

3.2.2 Viewing and printing the event information in the traffic analysis monitor 
window

You can print and view the event information received from a camera in the Traffic analysis monitor interface 
window. To do this, do the following:
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1.

2.
3.

4.

Select the required type of event on the Statistics tab in the Traffic analysis monitor window.

Go to the Events tab.
Select an event from the list, the information of which you want to display. 
As a result, the information about this event is displayed on the right side of the window: the camera name, 
the lane name, the event name, the date in the DD.MM.YYYY format, and the time of the event detection, as 
well as the photo from a camera that detects an event.

Click the Print button.
As a result, the Report on event window for viewing a report opens:
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1.
2.

a.

You can view it and, if necessary, print it by using the print button located on the top panel of the toolbar (for 
more details, see The program for viewing reports of the traffic analysis monitor).

Viewing and printing the information about the event detected by a camera is complete.

3.2.3 Viewing and printing the event statistics in the traffic analysis monitor 
window

You can print and view the event statistics received from a camera in the Traffic analysis monitor interface 
window. To do this, do the following:

Go to the Statistics tab in the Traffic analysis monitor window.
Select the statistic data that you want to display:

If you need the monitoring data, select the event type from the list, the statistics of which you want to 
display in a report. If you don't select anything, a report is built by all event types.
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b. If you need the archive data from a camera, then



Auto PSIM 2.0 (english) – Operator's Guide

Using the Auto PSIM software system– 14

i.

ii.

iii.

iv.
v.

3.

Go to the archive by clicking the Archive button.

In the Period from and to fields, specify the beginning and ending of the data receiving period 
using arrows and a calendar, respectively.
Click the Filters button to filter the data by the detector, as well as by an event and by the 
vehicle of this detector.

To save the selection, click the OK button; to reset, click the Cancel button.
Click the Refresh button.

Click the Print button.
As a result, the window for viewing the Statistics of violations, events and vehicle access report opens:
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1.
2.

3.

You can view and print a report using the print button located on the top panel of the toolbar (for more 
details, see The program for viewing reports of the traffic analysis monitor).
Viewing and printing the information about the statistics from a camera is complete.

3.3 Using the Vehicle Tracer interface object

3.3.1 Introduction
The Vehicle Tracer interface object includes the following components:

On-line monitor – is designed for displaying the data about identified plates and for handling alarms.
Events monitor – displays video frame with a vehicle, which plate is being recognized at the moment and 
also identified number and speed.
Alarm window – is designed for displaying the data about vehicles in case of coincidence of recognized 
plates with plates which are stored on the external orientation database.

Note.

Events monitor and Alarm window components are optional and aren't displayed with corresponding 
system settings (see the document Auto PSIM software package. Administrator's Guide).

https://docs.axxonsoft.com/confluence/spaces/AutoPSIM200en/pages/366051518/Administrator+s+Guide
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2.

a.
b.
c.
d.

e.
f.

g.
h.
i.
j.

k.

l.

m.

n.

3.3.2 Viewing the data about passing vehicle
You can see the passing vehicle data in the Events monitor window.

In the Events monitor window, the following data is displayed:

License plate recognizer (the name of the corresponding LPR channel object) (1);
An image of a vehicle with a caption in the black area, which can contain the following data (2):

Date and time of receiving the vehicle data.
Vehicle license plate.
Country.
Type of license plate (only for the Vehicle type recognition module, RR vendor and model 
recognizer module, or AR MMR module).
Vehicle speed.
Vehicle direction.
Speed, permitted on the controlled road area.
ID of speed detector.
Control point—name of the camera that captured the vehicle.
GPS coordinates.
Vehicle vendor (only for the Vehicle type recognition module, RR vendor and model recognizer module, 
or AR MMR module).
Vehicle model (only for the Vehicle type recognition module, RR vendor and model recognizer module, 
or AR MMR module).
Vehicle color (only for the Vehicle type recognition module, RR vendor and model recognizer module, 
or AR MMR module).
Other information about the speed detector (see Setting up the frame sign parameters).

Note

The Events monitor component may not be displayed due to the corresponding system settings.

Note

https://docs.axxonsoft.com/confluence/spaces/AutoPSIM200en/pages/366051968/Setting+up+the+frame+sign+parameters
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3. Recognized license plate and the license plate image (3).

3.3.3 Viewing the data about the last identified vehicle
The data about the last identified vehicle is displayed in the Last event group of the Online monitor window (left 
area of this window).

To change the composition of the titles, use the TitleFields registry key. Titles are specified 
in the format "date_and_time, number, country, speed, direction, allowed_speed, 
device_number, place_control, gps, type, make, model, color" case-insensitively (for 
details, see Registry keys reference guide, for more information on working with the 
registry, see Working with Windows OS registry).
You can use the parameters of the FontSize.N and TimestampFontSize.N registry keys to 
change the size of the black area containing captions and their font (see Registry keys 
reference guide. For more information on working with the registry, see Working with 
Windows OS registry).

•

•

•

Note

If the license plate hasn't been recognized, the UNDEFINED message will be displayed in the 
field.
If the characters of the recognized license plate are displayed incorrectly, it is necessary to 
change the font of the recognized license plate to the one that will contain all the characters 
of the corresponding country license plates (see Setting up the font of the recognized LP 
number).
The image of the recognized license plate is compressed or stretched to fit the red frame. By 
double-clicking in a separate window, you can view the image of a recognized license plate. 
The set window sizes are saved after you restart the computer.

•

•

Note

In case the AUTO-Uragan or AR-Auto module is used for recognition, allowed speed, vehicle speed 
and ID of speed detector are displayed only if the Speed traps server module is connected.
In case the alarm is registered for a vehicle (overspeeding, and/or identification of a plate in the 
external plates database), the field with a video frame is highlighted in red (2).

https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314513094/Registry+keys+reference+guide
https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314511425/Working+with+Windows+OS+registry
https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314513094/Registry+keys+reference+guide
https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314511425/Working+with+Windows+OS+registry
https://docs.axxonsoft.com/confluence/spaces/AutoPSIM200en/pages/366052030/Setting+up+the+font+of+the+recognized+LP+number
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To view the data about the last identified vehicle, do the following:

Note

If there is an event selected in the identified vehicles protocol or in the alarms protocol, the data about this 
event will be displayed in the Last event group (see Viewing the identified vehicles protocol, Viewing the 
alarms protocol).
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1.

2.

3.

A frame with a vehicle and a caption is displayed in the area (1).

The identified license plate and license plate image are displayed in the area (2).

Depending on the available data, the following information can be displayed in the area (3):

•
•

•

Note

If a license plate hasn't been recognized, NOT DETECTED message is displayed in the area.
If the characters of the recognized license plate are displayed incorrectly, it is necessary to 
change the font of the recognized license plate to the one that contains all characters of the 
corresponding country license plates (see Setting up the font of the recognized LP number).
Image of the recognized license plate is compressed or stretched to fit the red border.

https://docs.axxonsoft.com/confluence/spaces/AutoPSIM200en/pages/366052030/Setting+up+the+font+of+the+recognized+LP+number
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a.

b.

c.
d.

e.
f.

g.

h.

i.

j.
k.

l.
m.
n.
o.
p.

In the Recognizer field, the name of the license plate recognizer is displayed (the name of the 
corresponding LPR channel object).
In the Country field, the country to which the identified license plate belongs is displayed.

In the Recognition time field, the date and time of receiving the vehicle information is displayed.
In the Speed field, the vehicle speed is displayed.

In the Speed limit field, the speed limit allowed on this part of the road is displayed.
In the Speeding field, the difference between the captured vehicle speed and the speed limit allowed 
on this part of the road is displayed.

In the Validity field, the accuracy level of license plate recognition in percent is displayed (the 
minimum acceptable value is specified in the Min. recognition quality, % field on the settings panel 
of the LPR channel object, see Setting up the results filtering).
In the Direction field, the vehicle's direction is displayed (Undefined, To the camera, From the 
camera, To the right, To the left).
In the Regional code field, the regional code of the vehicle is displayed.

In the Camera field, the name of the camera, which captured the vehicle is displayed.
In the SDK data file field, the data file about the triggered module is displayed.

In the Address field, the camera location address is displayed.
In the Identificator (№) field, the camera ID number is displayed.
In the Certificate (№) field, the certificate number is displayed.
In the Calibration field, the calibration expiration date is displayed.
In the Vendor, Model and Color field, the vendor, model and color of the recognized vehicle are 
displayed.

Note

This field is not displayed when the IV module is used for recognition.

Note

In case the AUTO-Uragan or AR-Auto modules are used for identification, and the Speed traps 
server module is not connected, zero speed value is displayed.
Depending on the Vehicle Tracer settings, the speed is displayed in km/h or mi/h.

Note

This field is displayed if the speeding event was registered, otherwise this field isn't 
displayed.

Note

You can hide this field (see Setting up the Vehicle Tracer interface window).

Note

The SDK data file field is displayed only if the AR-Railway module is used.

Note

The Vendor, Model and Color fields are displayed only if the RR vendor and model 
recognizer is used.

https://docs.axxonsoft.com/confluence/spaces/AutoPSIM200en/pages/366051952/Setting+up+the+results+filtering
https://docs.axxonsoft.com/confluence/spaces/AutoPSIM200en/pages/366052012/Setting+up+the+Vehicle+Tracer+interface+window
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q.

r.

s.

In the Type field, the type of the recognized vehicle is displayed.

In the Dangerous goods class and Dangerous goods composition fields, the class and the contents 
of the dangerous cargo are displayed correspondingly.

In the GPS coordinates field, the coordinates of the camera installation are displayed.

Viewing the data about the last identified vehicle is complete.

3.3.4 Viewing the identified vehicles protocol
The identified vehicles protocol is displayed in the Online monitor window.

To access to the protocol, go to the Cars tab (1). The identified vehicles protocol is a table which contains the 
information about identified vehicles (2).

Note

This field is displayed only if the Vehicle type recognition module and/or the RR vendor and 
model recognizer are used.

Note

The Dangerous goods class and Dangerous goods composition fields are displayed only if 
the AR-Auto module and the Hazard Identification Number Recognition Engine (ADR) are 
used.

Note

In case an alarm is registered for a vehicle, the reason of alarm is also displayed in the Last event group.
The data about any event selected in the identified vehicles protocol or in the alarm protocol can be 
viewed in the same way (see Viewing the identified vehicles protocol, Viewing the alarms protocol).
A passing vehicle event can be created using a script (see Scripts used in the Auto PSIM software package).

https://docs.axxonsoft.com/confluence/spaces/AutoPSIM200en/pages/366052092/Scripts+used+in+the+Auto+PSIM+software+package
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1.
2.

3.

4.
5.

For every vehicle (event) the following data is displayed:

Video frame of the vehicle (3).
Identified vehicle LP number (4).

Vehicle speed.

LPR channel (5).
Date and time of receiving the information about the vehicle (6).

For alarms, the information about reasons of alarms is also displayed (see Alarms operation). The alarms which 
were not processed by the operator, are highlighted with red, and processed alarms are highlighted with yellow 
(see Alarm processing).

•
•

Note

If the LP number hasn't been recognized, UNDEFINED message will be displayed in the field.
If the characters of the recognized number are displayed incorrectly, it is necessary to 
change the font of the recognized number to the one that will contain all the characters of 
the corresponding country LP numbers (see Setting up the font of the recognized LP 
number).

Note

Vehicle speed is displayed only if the Speed traps server module is connected.

Note

https://docs.axxonsoft.com/confluence/spaces/AutoPSIM200en/pages/366052030/Setting+up+the+font+of+the+recognized+LP+number
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1.
2.

3.
4.

1.
2.

To view the detailed information about the event, do the following:

Left-click the required event.
As a result, the data about the vehicle will be displayed in the Last event group. Online update of the 
identified vehicles protocol will be suspended.
View the data about the event as described in the Viewing the data about the last identified vehicle section.
To restore the online update of the identified vehicles protocol click the Trace button in the upper area of 
the Online monitor window. 

Viewing the detailed data about the event is complete.

3.3.5 Alarms operation
Alarms operation is done in the Online monitor window.

Alarm is triggered by one of the following ways:

Automatically – in case of overspeeding or vehicle's plate identification in the external database.
Manually.

Manual alarm triggering
To enable the manual alarm triggering, do the following:

Any alarm event is duplicated: first, an event message with a recognized LP number is received without an 
alarm, then the same message is received with alarm. You can hide the processed events (see Hiding the 
processed events in the protocol).
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1.

2.
3.

Left-click the required event in the identified vehicles protocol (1).

Click the Alarm button (2).
As a result, this event will be highlighted in red, and if it is the first alarm, the Alarms protocol tab will 
become available (3). For the alarm which was triggered by the operator, the Marked by the operator cause 
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of alarm is displayed (4).

Manual alarm triggering is complete.

Viewing the alarms protocol
The Alarms protocol tab located in the upper area of the Online monitor window (1) automatically becomes 
available in case of the alarm event. The alarms protocol is a table which contains the information about the 
vehicles for which the alarms were triggered (2). 

Note.

For the information about alarms protocol, see Viewing the alarms protocol.

Note.

The information about the last alarm is displayed on the tab.
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1.

2.
3.

The alarms which were not processed by the operator, are highlighted with red, and processed alarms are 
highlighted with yellow (see Alarm processing).

To view the alarms protocol, do the same as to view the identified vehicles protocol (see Viewing the identified 
vehicles protocol). The only difference is that for an alarm the information about the alarm reason is also displayed:

Marked by the operator - means the alarm is triggered by the operator (the time of triggering is also 
displayed);
Is found in: <external database name> - means the identified LP is found in the external database;
Overspeeding - means the vehicle overspeeding is registered.

Detailed information about an alarm with the alarm reason is displayed in the Last event  group (see Viewing the 
data about the last identified vehicle). To view the detailed information about an alarm, do the same as to view the 
information about the event, registered in the identified vehicles protocol (see Viewing the identified vehicles 
protocol).

In case the identified vehicle LP is found in the External Plates Database, the information about the vehicle, stored 
in this base, will be displayed in the field (3). 

Note.

Any alarm event is duplicated: first, an event message with a recognized LP number is received without an 
alarm, then the same message is received with alarm. You can hide the processed events (see Hiding the 
processed events in the protocol).

Note

To display the side panel, click the (4) button.
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Alarm processing
Alarm processing is done in the following way:
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1.

2.

Left-click the alarm in the identified vehicles protocol or in the alarms protocol and click Accept button.

As a result, the event will be highlighted with yellow.

Alarm processing is completed.
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1.

2.

Hiding the processed events in the protocol
It is possible to hide the processed events in the identified vehicles protocol and alarms protocol. To do this, click 
the Processed Hide button. As a result, when all alarms are processed, then the Alarms protocol tab becomes 
hidden.

Viewing the alarm information in the Alarm window
Depending on the certain configuration, the Alarm window can be displayed automatically in the following cases:

If the recognized license plate number coincides with the number stored in the external online monitoring 
database. As a result, the  sign will be displayed at the top of the alarm 
window.
If the alarm event was triggered manually. As a result, the   sign will be displayed at 
the top of the alarm window.
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1.
•
•
•
•
•

•

The following data is displayed in the Alarm window:

Event information (1):
Date and time when the alarm event was recorded.
License plate number.
Recognition server name that recorded the event.
Vehicle direction of movement relative to the camera.
Name of the external database.

Current state of the alarm event.

Note

The field with the name of the external database is hidden if the the alarm event was 
triggered manually.

•
•

•

•

Note

There can be the following states of the alarm event:
Not confirmed - a new event that has not yet been confirmed.
Processing... - an alarm event is confirmed, but the information has not yet been 
recorded to the database.
Confirmed - the alarm is confirmed and recorded to the database (you may not 
notice this state since the event is deleted from the Alarm window after a successful 
confirmation).
Error - the confirmation is not recorded to the database due to the heavy load on the 
Server. It is necessary to confirm the event again.
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2.

1.

2.

The description from the stolen vehicles database (2): ID, LP number, storage time, search status, date and 
time of creation, comment, full name of the operator who created the report.

Use buttons to scroll the alarm events (3).

To confirm the active alarm status, click the Confirmed (information sent) button (5). As a result the alarm will be 
marked as received in the On-line monitor window, and deleted from the Alarm window. If the Trace checkbox is 
set (4), the confirmed alarm will be deleted from all Alarm windows in the distributed system.

To close the window of stolen vehicle report click the No confirmation button (6). If you click this button, the alarm 
status will not be changed in the On-line monitor (alarm will not be processed).

3.3.6 Adding comments to the events
It is possible to add the comments to the events. It can be done in the Online monitor window.

To add a comment to the event, do the following:

Left-click the event in the identified vehicles protocol or events protocol. Online update of the protocol 
displayed on the screen will be suspended.

Click Comment button.

Note

The table with the description from the stolen vehicles database is hidden if the the alarm event 
was triggered manually.

Attention!

It is not possible to add the comments to the accepted events (highlighted with yellow).
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3.

4.
5.

6.

Comments for license plate window will open in result.

In the Enter new comment field (1), specify a required comment.
Click the Add button (2) to add the comment to the event.

To view the comments to the event, left-click the required event in the identified vehicles protocol or events 
protocol. Comments will be displayed in the corresponding field (1).

Note

The Comments for license plate <LP number> field (3) displays the previous comments, if any, 
and the date when they were added to this event.

Note

To display the side panel, click the (2) button.
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Adding the comments to the event is completed.

3.3.7 Printing and exporting the vehicle data
Printing and exporting the vehicle data is done in the following way:
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1.

2.

Left-click the event in the identified vehicles protocol or events protocol. Online update of the protocol, 
displayed on the screen, will be suspended.

To build a report with vehicle data, click the Print button (1), which is located in the left corner of the 
bottom panel.
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3.

4.

The report preview program will be displayed.

If necessary, do the following operations with the report, then quit the report preview program by 
clicking the File -> Exit viewer in the main menu, or by clicking the  button in the top right corner.
The available operations for the report are listed in the table below.
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Operation Operation invocation

Main menu item Context menu item Toolbar 
button

Open the report, saved in .rsd 
or .xml

File -> Open -

Save the report in .rsd or .xml File -> Save -

Export the report to one of the 
common formats

File -> Export -

Print the report File -> Print -

Activate the «Hand» tool View -> Scrolling Scrolling

Zoom in the report pages View -> Zoom in Zoom in

Zoom out the report pages View -> Zoom out Zoom out

Enable dynamic scaling of report 
pages

View -> Dynamic scaling Dynamic scaling

Zoom in the selected area of the 
report

View -> Region scaling Region scaling

Scale in page size View -> In page size In page size

Scale in page width View -> In page's width 
size

In page's width size

Display pages in real size View -> Real size Real size

Enter or select from the list the 
required scale of displaying the 
report pages

View -> Set the scaling Set the scaling

Enable the nonstop paginal report 
displaying

- -
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Operation Operation invocation

Main menu item Context menu item Toolbar 
button

Enable the page-by-page report 
displaying

- -

Go to the first page Navigate -> The first page The first page

Go to the previous page Navigate -> Previous page Previous page

Go to the next page Navigate ->The next page The next page

Go to the last page Navigate ->The last page The last page

Go to the certain page (open the
«Go to page» dialog window)

Navigate -> Go to page - -

Display the previous view Navigate -> Back Back

Display the next view Navigate -> Forward Forward

Find the required characters in the 
report

Document -> Find Find

Update the report Document -> Update Update

Edit the report (open the editing 
program)

Document -> Edit the 
report

Edit the report

Display table of contents - -

Display information about the 
program to view the report

Help -> About program - -

Close the preview report program File -> Close - -
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1.

2.
•

Printing and exporting the vehicle data is completed.

3.3.8 Viewing the video archive by event
You can view the video archive by event from a video camera which is used for the license plate recognition.

To view the video archive by event, do the following:

Select an event in the identified vehicles protocol or alarms protocol by left-clicking on it. As a result of the 
operation, the online update of the protocol displayed on the screen will be suspended.

Click the Video archive button (1).
If the Monitor object is selected for the video archive playback, the video surveillance window of the 
corresponding monitor will switch to the archive playback mode. For details on working with the 

Note.

Operations with report files (opening, saving, exporting, and printing) are performed via the 
standard OS Windows dialog windows.

Note.

To go to the required page, enter the page number in the Page № field of the Go to page dialog 
window and then click OK.

Note

For this feature to work, the appropriate monitor should be selected on the settings panel of the Vehicle 
Tracer object (see Selecting the Monitor object for playing back the video archive).

https://docs.axxonsoft.com/confluence/spaces/AutoPSIM200en/pages/366052028/Selecting+the+Monitor+object+for+playing+back+the+video+archive
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•

1.
2.
3.
4.
5.
6.
7.
8.

video archive, see the Axxon PSIM. Operator's Guide, the most current version of the documentation is 
located in the AxxonSoft documentation repository).
If the AxxonOne monitor object is selected for the video archive playback (see Setting up the joint 
operation of Auto PSIM and Axxon One), the Axxon One interface window will open in the archive 
playback mode. For information on working with the video archive, see the Axxon One. Operator's 
Guide, the most current version of the documentation is located in the AxxonSoft documentation 
repository).

Viewing the video archive by event is completed.

3.3.9 Using filters in the protocols
You can select events to be displayed in the identified vehicles protocol and alarms protocol.

You can select the events using the following filters:

Speed.
Overspeeding.
License plate.
Validity.
Region.
Direction.
Alarm type.
Plate recognizers.

To select the filter, do the following:

Attention!

Both displayed and hidden in the protocol events are saved in the recognizers database of the Auto PSIM
software.

https://docs.axxonsoft.com/confluence/spaces/ASdoc/pages/84353171/AxxonSoft+documentation+repository
https://docs.axxonsoft.com/confluence/spaces/AutoPSIM200en/pages/366051980/Setting+up+the+joint+operation+of+Auto+PSIM+and+Axxon+One
https://docs.axxonsoft.com/confluence/spaces/ASdoc/pages/84353171/AxxonSoft+documentation+repository
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1. Click Filter button in the Online monitor window (1).
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2.

3.

•
•
•
•

Filters dialog window will be displayed in result.

From the Speed, km/h list (1) select the required filter, then specify the speed value(s) in the field(s) in km/h.
The following speed filters are available:

No filtering — the event is displayed in protocols with any vehicle speed;
More — the event is displayed in protocols if the vehicle speed exceeds the specified value;
Less — the event is displayed in protocols if the vehicle speed is below the specified value;
Interval — the event is displayed in protocols if the vehicle speed is within the specified speed range.
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4.

•
•

5.

•
•

•

6.

•

•

•

7.

•
•

8.

•
•

From the Speeding, km/h list (2) select the required filter, then specify the overspeeding value in the field in 
km/h.
The following overspeeding filters are available:

No filtering — the event is displayed in protocols with any vehicle overspeeding;
More — the event is displayed in protocols if the vehicle overspeeding exceeds the specified value.

From the Number list (3) select the required filter and then in the field enter the LP number or its part which 
identification leads to event displaying in protocols.
The following LP filters are available:

No filtering — the event is displayed in protocols with any vehicle LP number;
Register — the event is displayed in protocols if the vehicle LP number exactly matches the specified 
value;
Contains — the event is displayed in protocols if the vehicle LP number contains the specified value.

From the Validity list (4) select the required filter of the LP recognition validity percentage, then specify the 
percentage value in the field(s).
The following validity filters are available:

No filtering — the events are displayed for those vehicles which plates are recognized with any 
validity;
More — events are displayed in the protocol if the recognizing validity is higher than the specified 
value;
Interval — vehicle event is displayed in the protocol if the recognizing validity of vehicle plate 
belongs to the specified range of values.

From the Region list (5) select the required region filter, where the vehicle has been registered, and then 
enter the region number in the field.
The following region filters are available:

No filtering — the events are displayed in protocols for the vehicles, registered in any region;
Equal — the events are displayed in protocols for the vehicles, registered in the specified region.

From the Direction list (6) select the vehicle direction for which the event should be displayed in protocols.
The following direction filters are available:

No filtering — the events are displayed in protocols with any vehicle direction;
From camera — the event is displayed in protocols if the vehicle was moving away from the camera;

Note

Available range for specifying the Speed filter values is 0-300.

Note.

The overspeeding value is calculated as the difference between the recorded vehicle speed 
and the speed, permitted in the controlled area of the road.
Available range for specifying the Speeding filter values is 0-100.

Note.

The value specified for the Register and Contains filters may include usual characters and 
«*» characters which stand for an unidentified LP character. If the value contains one or 
several «*» characters, only the LPs which contain the unidentified characters in the 
specified combination, are displayed in the protocols.

Note

Available range for specifying the Validity filter values is 0-100.
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•

•
•
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•

•

10.

11.

Towards the camera — the events are displayed in protocols if the vehicle was moving towards the 
camera;
Undefined — the events are displayed in protocols if the vehicle direction was not determined.

From the Alarm type list (7) select the alarm type. Only alarms of the selected type will be displayed in 
protocols.
The following alarm type filters are available:

No filtering — the events are displayed in protocols with any alarm type or its absence;
Overspeeding — the events for which overspeeding has been registered are displayed in protocols;
LP found in database — the events for which the LPs have been found in the external plates 
database are displayed in protocols;
Alarm set by operator — the events, initialized manually, are displayed in protocols;
Running a red light — the events for which the red lights running has been registered are displayed 
in protocols;
Entered the oncoming lane — the events for which the entering the oncoming lane has been 
registered are displayed in protocols;
Crossed the stop line — the events for which the crossing the stop line has been registered are 
displayed in protocols;
Stop over crosswalk line – the events for which the stopping on the crosswalk line has been 
registered are displayed in protocols.

In the Plates recognizers (8) group set the checkboxes for those LP recognition Servers, which data should 
be displayed in protocols.
Click OK to save filters settings and close the Filters dialog window (10).

Filtering the events to be displayed in the protocols is complete.

3.3.10 Viewing the Vehicle Tracer errors
If there are no Vehicle Tracer errors, the Server status button in the right upper corner of Online monitor window 

is green . If errors are registered, the button is red .

Note.

To reset all the settings, click the Reset button (9).

Note

You can disable any filtering without changing the settings in the Filters dialog window. To do this, click 
the Show all button in the Online monitor window (2). All the registered events will be displayed in 
protocols in result. To resume the usage of filters, click this button again.
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1.

To view the Vehicle Tracer errors, do the following:

Click the Server status button.
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2.

3.
4.

5.

6.

The Errors dialog window will be displayed in result.

The data about the occurred errors is displayed in the field (1).
The list of all possible error sources is displayed in the field (2): LPR channels and/or external databases. 
Current error sources are marked by the   sign, idle sources are marked by the   sign.
To delete the data about the errors and close the Errors dialog window, click the Clear button (3).

To close the Errors dialog window without deleting the data about the errors, click the   button.

Viewing the Vehicle Tracer errors is completed.

3.3.11 Creating the additional Online monitor components
It is possible to create the additional Online monitor interface components. To do this, double left-click the Events 
monitor component. As a result, the additional Online monitor component will be displayed in the center of the 
screen.
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1.
2.

Working with Additional Online monitor components is similar to working with the main Online 
monitor component.

3.3.12 Searching the events in the recognizers databases

Opening and closing the Event search in the Recognizers DBs window

On this page:

General info about searching the events in the recognizers databases
Opening and closing the Event search in the Recognizers DBs window
Opening the Event search in the Recognizers DBs window using the Windows command line

General info about searching the events in the recognizers databases

You can search the events in the the Auto PSIM recognizers databases via the Event search in the Recognizers 
DBs dialog window.

The full list of operations provided to the operator in the window Event search in the Recognizers DBs, is the 
following:

Searching the events, stored in the Auto PSIM local or remote recognizers databases.
Printing the search results reports.
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3. Creating the personal LPs database (Active tracking database).

Opening and closing the Event search in the Recognizers DBs window

To open the window, click the Search button in the Online monitor interface object.

As a result, the Event search in the Recognizers DBs window will be opened.

To minimize the Event search in the Recognizers DBs window, click the (1) or (2) buttons. As a result, the window 
will be minimized to the Taskbar but will continue working.
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1.
2.
3.

To close the Event search in the Recognizers DBs window, select the File → Exit item in the main menu (3). As a 
result, the window will be closed completely.

Opening the Event search in the Recognizers DBs window using the Windows command line

The Event search in the Recognizers DBs window can also be opened using the Windows command line, even 
when the Axxon PSIM is unloaded. To do this, run the following command:

<Axxon PSIM installation directory>\Modules>VehiclePlateSearch.run "C:
\Users\<Username>\AppData\Local\Temp\PlateSearchSettings_1.xml"

Command example:

C:\Program Files (x86)\Axxon PSIM\Modules>VehiclePlateSearch.run "C:
\Users\User\AppData\Local\Temp\PlateSearchSettings_1.xml"

"C:\Users\UserName\AppData\Local\Temp\PlateSearchSettings_1.xml" - is the path to the 
PlateSearchSettings_1.xml configuration file, which is generated each time you click the Search button in the 
Online monitor interface window in accordance with the current system configuration. If the system configuration 
has changed, then to re-generate the file, click the Search button again or make changes to the file manually.

Configuring the events search

•

•

•

On the page:

Selecting the recognizer 
databases for the 
events search
Configuring the search 
results
Configuring the video 
archive

Events search is set up in the following order:

Select the database, where events should be searched.
Configure the displaying of search results.
Configure the video archive.

Selecting the recognizer databases for the events search 

To select the recognizer databases for events search, first select the servers where the required LPR databases are. 
To do this, in the main menu of the Event search in the Recognizers DBs window, in the Servers item, select the 
required server names. To select all system servers, click Servers → Select all.

Note

If you work in the Event search in the Recognizers DBs window with the Axxon PSIM unloaded, then the 
vehicle frames and license plate images will not be displayed.
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Configuring the search results

Event search results are displayed in the table. You can choose which table columns should be displayed and which 
shouldn't, add new columns and also edit the columns displayed names.

To configure the search results displaying, do the following:

In the main menu of the Event search in the Recognizers DBs, click Settings.

As a result the Settings dialog window is displayed. The search results displaying is configured on 

Note

Each time you open the Event search in the Recognizers DBs window, the access to the selected servers 
is checked. If any of the selected servers is unavailable, then after the timeout expires, the header of the 
search results table will display a list of servers to which it was not possible to connect, and the header 
itself will be highlighted with red. If all servers are available, the header will be highlighted with green.
The timeout for connecting to the selected Auto PSIM servers is set on the settings panel of the Vehicle 
Tracer module window (see Setting up the Vehicle Tracer interface window).
If you use the Server/Remote Administrator’s workstation and Remote Client configuration, you must set 
the value of the string parameter of the registry key VehiclePlateSearch.UseRestIp=1 to enable the event 
search (see Registry keys reference guide).

https://docs.axxonsoft.com/confluence/spaces/AutoPSIM200en/pages/366052012/Setting+up+the+Vehicle+Tracer+interface+window
https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314513094/Registry+keys+reference+guide
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2.

the Configure fields tab. 

In the field (1) set the checkboxes for the columns that should be displayed in search results table.

Column name (by default) Column content

Frame Video frame with a vehicle

License plate Video frame with vehicle LP number

Number Identified LP number

Region number Region number of the identified number

LP region Region of the identified LP number

Recognizer name LPR channel object name, corresponding to the 
vehicle detector

Note

To display all the available columns in the search results table, set the Select\deselect checkbox 
(2). If this checkbox isn't set, the search results table is not displayed.



Auto PSIM 2.0 (english) – Operator's Guide

Using the Auto PSIM software system– 51

Column name (by default) Column content

Vehicle speed Vehicle speed

Country The country of the recognized LP number

Date Date and time of the vehicle identification

Recognizer address LP detector address

Valid speed, km/h Speed in km/h permitted on the road area covered by 
the detector

Speeding, km/h Vehicle overspeeding in km/h

Direction An indication that the vehicle was moving towards the 
detecting camera

Validity, % LP identification accuracy in percent

Alarm time Time of the LP detection alarm registration

Alarm initiated by Name of the operator who initiated the alarm

Alarm accepted by Name of the operator who processed the alarm

Comment from external DB Comment on the vehicle report in the external plates 
DB added by the operator

Alarm accepted at Time of the LP detection alarm acceptance by the Auto 
PSIM operator

Alarm handing delay, sec Time between registering the alarm and its acceptance 
by the operator

Comment Comment on the event added by the operator

Alarm type Alarm type (overspeeding or vehicle identification in 
the external plates databases)

Alarm processed An indication that the alarm was accepted by the 
operator
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3.

Column name (by default) Column content

External DB An indication that the alarm was found in the external 
plates database

Red-light phase start time Time of the red-light phase start during which the 
alarm was registered (if the Red lights running module 
is used)

Time passed since the red-light phase start Time between the red-light phase start and the alarm 
registration (if the Red lights running module is used)

Category Vehicle category identified by license plate

Camera Name of the video camera which captured the vehicle

Type Vehicle type (if the Vehicle type recognition module 
and/or the RR vendor and model recognizer are used)

Vendor Vehicle vendor (if the RR vendor and model 
recognizer is used)

Model Vehicle model (if the RR vendor and model recognizer is 
used)

Vehicle color Vehicle color (if the RR vendor and model recognizer is 
used)

Frame from a synchronous camera Video frame from a synchronous video camera 
displaying a vehicle 

Dangerous goods class Class of the dangerous cargo (if the AR-Auto module 
and the Hazard Identification Number Recognition 
Engine (ADR) are used)

Dangerous goods composition Contents of the dangerous cargo (if the AR-Auto
module and the Hazard Identification Number 
Recognition Engine (ADR) are used)

To add a new column to the search results table, do the following:
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a.

b.

c.

d.

4.
a.
b.
c.

d.

5.

Click Add (3). As the result the Configure fields dialog window will be displayed.

In the Field name in the DB field, specify the name of the column in the connected recognizer 
database, which content should be displayed in the search results table (1).
In the Field name in the interface field, specify the name for this column which should be displayed 
in the search results table (2).
Click Save to save the applied changes and close the Configure fields dialog window (3).

To edit the column name in the search results table, do the following:
In the Configure fields group select the column, which name should be changed (1).
Click Edit (4).
As a result the Configure fields dialog window with the disabled Field name in the DB field is 
displayed.

In the enabled Field name in the interface field, specify the new column name and save the changes 
(see steps 4.3-4.4).

Click OK to save the changes and close the Configure fields dialog window (5).

Configuring the displaying of the search results is completed.

Configuring the video archive

Video recordings of the events are displayed in the video archive. To configure the video recordings playback, do 
the following:

Note

Click Cancel to close the window without saving any changes (4).

Note

Click Cancel to close this window without saving any changes (6).
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In the main menu of the Event search in the Recognizers DBs, click Settings.

As a result the Settings dialog window is displayed.
Go to the Configure video archive tab (1).

From the Overlay drop-down list, select the Overlay mode (2).

The overlay modes are presented in the table.

Overlay mode Description

No Videos from the video cameras are not processed by the video 
card

Overlay 1 Videos from the video cameras are processed as one stream

Note

Overlay is used to process the video using the video card and Direct X libraries, before it is 
displayed. Overlay allows to improve the image due to optimization of the pixel color settings. At 
the same time, the CPU load is reduced as the video is processed with the resources from the video 
capture card.
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5.

1.

Overlay 2 (set by default) Videos from the video cameras are processed independently of 
one another

In the Compression field, set the cursor according to the required video compression rate (3).
Default—means the original compression rate, size and quality of the video corresponds to the video 
image that is sent to the server.
None—means minimal compression rate, full video size, best quality.
Maximum—means maximum compression rate, minimal video size, worst quality.

To save changes click OK (4).

The configuring of the video recordings playback is completed.

Creating a search query

•

•

•

On the page:

Creating a search query 
by recognized vehicles
Creating a search query 
by alarms
Starting a search

You can form a search query:

By recognized vehicles (the Search by vehicles tab).
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2.

1.

By alarm events (the Search by alarms tab).

Creating a search query by recognized vehicles

To create a search query by recognized vehicles, do the following:

Go to the Search by vehicles tab (1).
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a.

•
•

b.

In the Vehicle's license plate group:

From the Search operation drop-down list (2), select a logical construction, used for uniting several 
elements of the key phrase, which correspond to the LP numbers or their parts that are being 
searched:

AND—for searching by numbers, containing all the elements of the key phrase;
OR—for searching by numbers, containing at least one element of the key phrase.

In the field (3), enter the key phrase. The elements of the key phrase can be separated by comma "," 
or semicolon ";".

Picture-characters Description of a picture-
character

Example of search query

% Any number of any characters Search query A%385%78 returns 
LP numbers, containing the 
elements A, 385 and 78, divided by 
any number of characters, for 
example AO38578 and A385MK78

_ (underscore) Any single character Search queries _91_AT_7
and T9__AT07 return the LP 
number T919AT07

Note

The key phrase can include usual characters and picture-characters in the required 
combination.
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c.

d.
e.

f.

g.
i.

ii.

h.

i.

Picture-characters Description of a picture-
character

Example of search query

[] Any single character within the 
range [A-E] or in the set [ABCDE]

Search query [E-M][2-5]53 returns 
LP numbers, containing the 
sequence of four characters. The 
sequence ends in 53, the first 
character belongs to the range E-M, 
the second one belongs to the 
range 2-5, for example, K453MH02, 
M253BT63

[^] Any single character outside the 
range [^A-E] or the set [^ABCDE]

Search query [^E-M]499 returns LP 
numbers, containing the sequence 
of four characters. The sequence 
ends in 499, the first character does 
not belong to the range E-M, for 
example B499BK57 and H499578

Set the License plate not recognized checkbox (4) if it is necessary to display all numbers.

Set the Partly recognized checkbox (5) if it is necessary to display partially recognized numbers.
Set the 'Space' in car number checkbox (6) if it is necessary to display the numbers that contain a 
space between the characters.
Set the Acceptable error amount checkbox (7) to display the numbers with the errors (character 
mismatches), the amount of which is indicated in the drop-down list.
From the Report type drop-down list (8), select the type of vehicle search:

Passes—standard search.
Escort vehicles—search for all vehicles that have been recorded near the specified vehicle 
within the time interval set in the Interval before/after, s parameter.

In the Interval before/after, s field (9), specify the time in seconds within which it is necessary to 
search for the vehicle.

In the Min. number of occurrences field (10), specify the minimum number of vehicle records within 
the time set in the Interval before/after, s parameter.

Note

The License plate not recognized checkbox is available only if the OR logical construction 
is selected in the Search operation drop-down list.

Note

This parameter is available if the Escort vehicles value is selected in the Report type drop-
down list.

Note

This parameter is available if the Escort vehicles value is selected in the Report type drop-
down list.
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In the Regional code group, set the checkboxes for those regional codes, the events for which must be 
returned during search.

In the LP region group, set the checkboxes for those regions, the events from which must be returned during 
search.

In the LP colors group, select color of regional code and basic color of the license plate.

In the Date/Time group, specify the time range within which the required events have been registered. By 
default, this range is not activated (the from and to checkboxes are clear). To activate it, set the from and/or 
to checkboxes and then click the  button and in the appeared calendar, set the required date. Enter the 
required time in the field From and/or To. If you select only the lower or upper limit, the search query 
returns the events, registered before or after the set time, respectively. To disable the search by date and 

Attention!

Only those regional codes are displayed, the license plate of which has already been recognized 
earlier, since this information is received from the database of recognized license plates.

Attention!

Only those regions are displayed, the license plate of which has already been recognized earlier, 
since this information is received from the database of recognized license plates.

Attention!

Only those license plate colors are displayed, the license plate of which has already been 
recognized earlier, since this information is received from the database of recognized license 
plates.
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time, clear the from and to checkboxes.

In the Plate recognizers group, set the checkboxes for those plate recognizers, the events from which must 
be returned during search.

In the External DB group, set the checkboxes for those external databases, the events of finding the 
recognized number from which must be returned during search.

Note

Information about objects deleted from Axxon PSIM isn't displayed in the Plate recognizers group. 
To search by deleted servers of plate recognizers, in the View menu of the Event search in the 
Recognizers DBs window, select Show deleted.

After this, all deleted LPR channels are displayed in the Plate recognizers group. Set checkboxes 
for those plate recognizers which you want to use during search.

Note

The External database group contains a list of all databases that have ever been used together 
with the Vehicle Tracer module, but, by default, databases deleted from Axxon PSIM aren't 
displayed in the list. To search by deleted databases, in the View menu of the Event search in the 
Recognizers DBs window, select Show deleted.
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From the Registered speed group, select the required filter of vehicle speed and then enter the threshold 
values of vehicle speed. The following speed filters are available:

<not important>—events of the vehicle, moving with any speed will be returned;
more—events of the vehicle, moving with a speed, exceeding a threshold value, will be returned;
less—events of the vehicle, moving with a speed, not exceeding a threshold value, will be returned;
interval—events of the vehicle, moving with a speed, belonging to a specified interval threshold 
values, will be returned;

From the Direction drop-down list, select the required filter by the direction of vehicle movement. The 
following direction filters are available:

<no matter>—events of the vehicle, moving in any direction relative to the license plate recognition 
camera will be returned;
undefined—events of the vehicle, which direction of movement is undefined, will be returned;
from the camera—events of the vehicle, moving away from the license plate recognition camera will 
be returned;
to the camera—events of the vehicle, moving towards the license plate recognition camera will be 
returned;
to the right—events of the vehicle, moving to the right of the license plate recognition camera will be 
returned;
to the left—events of the vehicle, moving to the left of the license plate recognition camera will be 
returned.

In the Countries group, set the checkbox for the country, the events from which must be returned during 
search.

As a result, all external databases deleted from the system are displayed in the list. Set checkboxes 
for those databases which you want to use during search.

Attention!

Only those countries are displayed, the license plate of which has already been recognized earlier, 
since this information is received from the database of recognized license plates.
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In the Comment group:

From the Search operation list (1), select a logical construction, used for uniting several elements of 
the key phrase, corresponding to the comments to the events that are being searched for:

AND—for searching by comments, containing all the elements of the key phrase;
OR—for searching by comments, containing at least one element of the key phrase.

In the field (2), enter the key phrase, containing one or several elements separated by a comma and 
corresponding to the comments to the events, which are being searched for, and which were 
specified in the Online monitor window (see Adding comments to the events).
Set the Empty comment checkbox (3) to include the uncommented events in the search.

Set the Non-empty comment checkbox (4) to include only the commented events in the search.
From the Validity list, select the required validity filter and then enter the threshold of validity values. The 
following validity filters are available:

<not important>—events of the vehicles, which numbers have been recognized with any validity, 
will be returned;
more—events of the vehicles, which numbers have been recognized with validity, exceeding the 
entered threshold value, will be returned;
less—events of the vehicles, which numbers have been recognized with validity, not exceeding the 
entered threshold value, will be returned;
interval—events of the vehicles, which numbers have been recognized with validity, belonging to the 
specified interval of threshold values, will be returned.

In the Recognition cameras field, set the checkboxes for the cameras, the events from which must be 
returned during search.

Note

This parameter is available if the OR logical construction is selected in the Search 
operation drop-down list.
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In the Vendor group, set the checkbox for the vendors, from which vehicles you want to return events during 
search.

In the Model group, set the checkbox for the vehicle models, the events from which you want to return 
during search.

In the Type group, set the checkbox for the vehicle types, the events from which you want to return during 
search.

In the Vehicle color group, set the checkbox for the vehicle colors, the events from which you want to return 
during search.

In the Category group, set the checkbox for those categories of vehicles, the events from which you want to 
return during search.
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4.

To clear the Search by vehicles tab from the entered search criteria, click the Reset button.

Creating a search query by alarms

To create the search query by alarms, do the following:

Go to the Search by alarms tab (1).

Repeat steps 2-8 of the Creating the search query by recognized vehicles section as applied to the 
interface elements of the Search by alarms tab.
From the Permitted speed list, select the required speed filter, permitted on the controlled road area and 
then enter the threshold speed values in km/h. The following filters of the permitted speed are available:

<not important>—events, registered on the road area with any permitted speed will be returned;
more—events, registered on the road area with any permitted speed, exceeding the entered 
threshold value will be returned;
less—events, registered on the road area with any permitted speed, not exceeding the entered 
threshold value will be returned;
interval—events, registered on the road area with the permitted speed, that belong to the entered 
threshold value interval will be returned.

From the Alarm handling delay, s list, select the required filter according to the alarm handling delay and 
then in the fields, enter the threshold values of delay time in seconds. The following filters of alarm handling 
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delay are available:

<not important>—alarm events, accepted in any time after being registered or unaccepted at all, 
will be returned;
more—alarm events, accepted with a delay, exceeding the entered threshold value, will be returned;
less—alarm events, accepted with a delay, not exceeding the entered threshold value, will be 
returned;
interval—alarm events, accepted with a delay, belonging to the entered threshold value interval, will 
be returned.

From the Alarm processed list, select the required alarm processing filter. The following alarm processing 
filters are available: 

<no matter>—both processed and unprocessed events will be returned;
alarm is not processed—only unprocessed events will be returned;
alarm processed—only processed events will be returned.

In the Alarm accepted by group, set the checkboxes for the operators who received the alarm events to 
display these events in the search query.

In the Alarm type group, set the checkboxes for the alarms, which must be returned in the results of a 
search query:

Alarm is set by operator—manually initiated alarm events will be returned;
Entered the oncoming lane—events, for which entering the oncoming lane has been registered, will 
be returned;
Marking rules violation—events, for which the violation of marking rules has been registered, will be 
returned;
Parking rules violation—events, for which the violation of parking rules has been registered, will be 
returned;
Plate number is found in the DB—events of the vehicles, which license plates have been found in 
the external database, will be returned;
Red light violation—events, for which running a red light has been registered, will be returned;

Note

This parameter is available if the <not important> or alarm processed value is selected in the 
Alarm processed list (see above).
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Red light violation at intersection—events, for which running a red light at intersection has been 
registered, will be returned;
Run over stop line—events, for which stopping over the stop line has been registered, will be 
returned;
Speeding—events, for which speeding has been registered, will be returned;
Stop over crosswalk line—events, for which stopping over the crosswalk line at the stoplight has 
been registered, will be returned.

In the Comment from external DB group:

From the Search operation list (1), select the logical construct which is used to combine several 
elements of the key phrase, that correspond to the comments to the events you are searching for in 
external databases:

AND—to search for comments that contain all elements of the key phrase;
OR—to search for comments that contain at least one element of the key phrase.

In the field (2), enter a key phrase consisting of one or more elements, separated by commas, that 
correspond to the comments to the events you are searching for in external databases that are 
specified in the External DB group (see Creating the Active tracking database).

From the Speeding list, select the required speeding filter and then enter the threshold values of speeding in 
km/h. The following filters of the speeding are available:

<not important>—events of the vehicle, moving with any speeding or with the absence of it, will be 
returned;
more—events of the vehicle, moving with speeding, exceeding the entered threshold value, will be 
returned;
less—events of the vehicle, moving with speeding, less than the entered threshold value, will be 
returned;
interval—events of the vehicle, moving with speeding, in the entered range of threshold values, will 
be returned.

From the Red light shows at, s list, select the required filter for the red light start and then in the fields, 
enter the threshold values in seconds. The following filters of the running a red light are available:

<not important>—events of the vehicles, which violated a red light, will be returned;
more—events of the vehicles, which violated a red light after the entered threshold value of the red 
light start, will be returned;

Note

This parameter is available if the Speeding checkbox is set in the Alarm type group.
The value of speeding is calculated as a difference between the fixed vehicle speed and the 
speed, permitted on the controlled area of the road.
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less—events of the vehicles, which violated a red light before the entered threshold value of the red 
light start, will be returned;
interval—events of the vehicles, which violated a red light within the entered range of threshold 
values of the red light start, will be returned.

 In the Alarm initiated by field, select the required operators who initiated alarm events. The corresponding 
alarm events will be displayed in the search results.

To clear the Search by alarms tab from the entered search criteria, click the Reset button.

Starting a search

After forming a search query by vehicles or by alarms, click the Find button.

As a result, a table with search results that match the entered search criteria is displayed:

Note

This parameter is available if the Red light violation checkbox is set in the Alarm type 
group.

Note

This parameter is available if the Alarm is set by operator checkbox is set in the Alarm type group.
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If the Escort vehicles report type was selected, the search results table looks like this:
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Viewing, printing and exporting the search results
Columns of the Search results table are displayed according to the settings configured in the Configure fields
dialog window (see Configuring the events search).

The description of the columns content is given in the same section of the Guide.
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To navigate in the results table, use the following interface elements:

button —go to the first page of the table;

button —go to the previous page of the table;

field —go to the required page of the table;

field —the number of pages in the table;

button —go to the next page of the table;

button —go to the last page of the table.
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You can print or export the search results as a report (see Printing the search results report), as well as export to the 
JPG file (see Exporting the search results to JPG files).

You can sort the search results within a page by clicking the corresponding column. 

You can sort the search results by date on all pages by clicking the Date column.

Printing the search results report

The event search results can be printed as a report. To do this, do the following:

In the main menu of the Event search in the Recognizers DBs window, click File → Print (1).

As a result, the report preview program will launch.

Note.

To go to the required page, enter its number in the field , and then press Enter on the keyboard.
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If the Escort vehicles report type was selected:

Perform the necessary operations with a report in the report viewing window. All operations in this window are 
similar to those described on the page Printing and exporting the vehicle data.
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If there are more than 1000 entries in the search results the following message will be displayed before the preview 
report program launch.

Click Yes to continue. Click No to return to change the search criteria.

Exporting the search results to JPG files

The events search results can be exported to JPG files. For each event, the following objects will be created:

a JPG file containing the frame from the main camera;
a JPG file containing the frame from the synchronous camera with the *_secondary.jpg name (if the 
synchronous camera is configured);
an archive containing meta data in the ARENA module format (if Debug4 mode is enabled). This 
functionality is required for integration with the TRIS.

To export the events search results to JPG files, do the following:

In the main menu of the Event search in the Recognizers DBs window, click File → Export (1).

Note

If the search results contain more than 1000 entries, the report may not be generated, because Windows 
does not allocate more than 2 GB of memory to the x86-bit processes.
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In the opened window select the folder in which the JPG files with search results are to be exported. 
Click OK.

As a result all JPG files corresponding to event search results will be exported to the specified folder. File 
names contain the following information:
detection tool ID, detection tool name, date and time, license plate, country (if defined), photo type (for 
example, secondary indicates that a photo is taken from a second synchronous camera, if there is any).

Exporting the events search results to JPG files is complete.

Exporting the search results to CSV file

You can export the event search results to a CSV file.

To export event search results to a CSV file, do the following:
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In the main menu of the Event search in the Recognizers DBs window, click File → Export to CSV (1).

In the opened window, select the folder in which the CSV file with search results is to be exported, and click 
Save.

As a result, a CSV file containing the search results will be created in the specified folder.
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Exporting the events search results to a CSV file is complete.

Previewing and printing the event data
To view the event data, double left-click the corresponding string in the search results table. The View event dialog 
window will open.

In the View event window, the following event information is displayed:

The main video frame with a caption in the black area which contains the following data (1):
date and time of receiving the vehicle data;
vehicle license plate;
counrty;
type of license plate (only for the Vehicle type recognition module, RR vendor and model recognizer
module, or AR MMR module);
vehicle speed;
vehicle direction;
speed, permitted on the controlled road area;
ID of speed detector;
control point—name of the camera that captured the vehicle;
vehicle vendor (only for the Vehicle type recognition module, RR vendor and model recognizer module, 
or AR MMR module);
vehicle model (only for the Vehicle type recognition module, RR vendor and model recognizer module, 
or AR MMR module);
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vehicle color (only for the Vehicle type recognition module, RR vendor and model recognizer module, 
or AR MMR module).

Additional video frame if any (2).

Field (3) with the following data:
recognized license plate of a vehicle;
image of a recognized license plate.

Field (4) with the following data:
recognizer of a vehicle license plate;
country;
date and time when the vehicle license plate was recognized;
validity in %;
vehicle direction in relation to the license plate recognition camera;
name of the camera that captured the vehicle;
vehicle speed;
vehicle vendor (only for the Vehicle type recognition module, RR vendor and model recognizer module, 
or AR MMR module);
vehicle model (only for the Vehicle type recognition module, RR vendor and model recognizer module, 
or AR MMR module);
vehicle color (only for the Vehicle type recognition module, RR vendor and model recognizer module, 
or AR MMR module);
type of license plate (only for the Vehicle type recognition module, RR vendor and model recognizer
module, or AR MMR module).

Vehicle data from the external LP database if the recognized LP has been found there (5);
Comments to the event (6).

To print the Report or/and export it to one of the most commonly used formats, click the Print button (7). A 
program to preview the report will launch. The vehicle data report will be displayed in the window of this program.

Note

By double-clicking in a separate window, you can view the frame with a recognized vehicle. 
The set window sizes are saved after you restart the computer.
You can use the parameters of the FontSize.N and TimestampFontSize.N registry keys to 
change the size of the black area containing captions and their font (see Registry keys 
reference guide. For more information on working with the registry, see Working with 
Windows OS registry).

Note

By double-clicking in a separate window, you can view the frame with a recognized vehicle. The set 
window sizes are saved after you restart the computer.

Note

By double-clicking in a separate window, you can view the image of a recognized license 
plate. The set window sizes are saved after you restart the computer.

https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314513094/Registry+keys+reference+guide
https://docs.axxonsoft.com/confluence/spaces/Psim2en/pages/314511425/Working+with+Windows+OS+registry
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Perform the necessary operations with a report and then quit the program by clicking the File -> Exit menu items, 
or by clicking the  button (see step 4 in Printing and exporting the vehicle data).

Creating the Active tracking database
The Active tracking database is the Auto PSIM database and is filled up by operator via the Vehicle Tracer module.

For total interaction between the Active tracking database and the Vehicle Tracing module the following 
conditions should be met:

The Active tracking database should be connected to Auto PSIM as an external plates database.
This external database should be used by the Vehicle Tracer module for analyzing the recognized license 
plates.

If the following conditions are met, the interaction between the Active tracking database and the Vehicle Tracer
module is performed in the following way:

The operator adds the vehicle LP to the Active tracking database via the Vehicle Tracer module, and 
specifies the reason of its adding. 
The Vehicle Tracer module compares the passing vehicle LP with the LPs stored in the Active tracking
database. If the correspondence between these LPs is established, the alarm event is generated with the 
location of the number in the corresponding database.

The Active tracking option is convenient to be used in the Auto PSIM distributed system, as it enables the operator 
at his workstation to notify the remote workstation operators about the vehicle that is to be captured.

The information about the vehicle is added to the Active tracking database as follows:

Click the External Plates DB (1) in the main menu of the Event search in the Recognizers DBs window.

•

•

Note.

It is impossible to remove and change records via the Vehicle Tracer module except for changing 
the suspect vehicle profile status.
All operator actions with the Active tracking database (for example, adding or deleting a suspect 
vehicle profile, changing the start or end date of the suspect vehicle profile) are logged.
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As a result the Internal SVDBs dialog window will open.

Click Enter to add records to the database.
Indicate the start and expiration date of the suspect vehicle profile (1). All alarm events about the number 
being in the corresponding external LP database will be guaranteed to be stored until the expiration of the 
suspect vehicle profile, despite the periodic procedure for clearing the archive of events (see Configuring the 
retention period of the database records).

In the License plate number field (2) specify the vehicle number. To enter a two-line number, use 
two underscore characters "__" as a line separator, for example: 123ABC__TH777.

https://docs.axxonsoft.com/confluence/spaces/AutoPSIM200en/pages/366051945/Configuring+the+retention+period+of+the+database+records
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If it is necessary to check the fact of vehicle driving to the vehicle report by all boundaries, do the following:
set the Check the fact of driving checkbox (3);
enter the time period for which it is required to check the fact of vehicle driving to the vehicle report 
by all boundaries (4).

The Operator field (5) indicates the current operator creating the suspect vehicle profile.
In the User rights list (6), set the check boxes for those Axxon PSIM user rights that should receive an alarm 
event when the LP number is found in the database. In order for only the current operator to receive an 
alarm event, it is necessary to uncheck all the boxes in the User rights list.

If necessary, in the Additional info field (7) enter a description of the reason for creating the 
suspect vehicle profile.
Click Save to save changes (8).

Go to the All reports of vehicles found in DB tab to change the status of suspect vehicle profile.

The table displays a list of all suspect vehicle profiles in the database that the current operator has access to 
(1):

In the Number column, the LPs on the wanted list are displayed.
In the Date and Time column, the time of adding the vehicle report to the database is displayed.
In the End time column, the expiration time of the suspect vehicle profile is displayed.
In the Comment column, the reason by which the vehicle report is created is displayed.
In the Active column, the checkboxes are set for the active vehicle reports.
In the Operator column, the operator who added the vehicle report to the database is displayed.

Note

To receive alarm events, it is necessary that the selected user has full access to the External plates 
DB object, to which the suspect vehicle profile is entered. If any restrictions are set in the user rights 
for the External plates DB object, then users with such rights will not receive alarm events.

Note.

The suspect vehicle profiles added to the database receive the Active status.
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In the User rights column, the rights of users who will receive an alarm event about finding a number 
in the database is displayed.

The Date and Time, End time and Comment columns can be edited. To do this, select the corresponding 
value in the column, then double-click on this value or click on the Edit button (2).

To change the suspect vehicle profile status, in the Active column (3), set the check boxes for the suspect 
vehicle profiles that are active, or uncheck the boxes for those suspect vehicle profiles that are inactive.
To search for the vehicle in the table, enter the search request in the Find field (4) and click the Search
button. A list of vehicles matching the search request will be displayed.

To remove the selected suspect vehicle profile, click Delete (5).
To save the changes, click Save (6).
To update the list of suspect vehicle profiles, click Refresh (7).
To save all suspect vehicle profiles to a CSV file, click Change (8) and select the Save to CSV item.
To load previously saved suspect vehicle profiles from a CSV file, click Change (8) and select the Import 
from CSV item.

Adding the vehicle data to the External Plates DB is completed.

Viewing the video archive by an event
Viewing the video archive by event can be initiated in three ways:

Right-click the required event, and in the contextual menu select the Video archive option.

Left-click the required event, and on the keyboard push the Ctrl + M keys combination.
Holding the Shift key, double left-click the required event.

As a result, the video archive with videos of the event will open.

Note

You can sort the suspect vehicle profiles by clicking on the name of the corresponding 
column.

Note

The columns Number, Operator and User rights are not editable.

Note

The data is searched in the following fields: Number, Date and Time, Operator, Comment.
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To close the video archive, click the  button in the right upper corner of the window.

Viewing the video archive by event is completed.
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4 Description of the Auto PSIM user interface

4.1 Description of the interfaces of the Traffic analysis monitor object

4.1.1 The interface of the Traffic analysis monitor object

•
•
•

On the page:

The Statistics tab
The Events tab
The event archive mode 
from cameras

The interface of the Traffic analysis monitor window contains the following elements.

The Statistics tab

By default, the event monitoring mode is enabled. To switch to the archive mode, use the Archive button.

Description of the interface elements.
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Number of the element Element Description of the element

1 Data source RR channels from which the statistic data is 
displayed

2 Statistic data The table of the general statistic data received 
from cameras, by event types, including the 
number and type of the vehicle

3 The Print button Prints the statistic data

4 The Archive button Switches to the event archive mode from 
cameras

5 The Clear button Deletes the statistic data from the table

The Events tab

Description of the interface elements.

Number of the element Element Description of the element

1 Events detected by cameras The table of events detected by cameras
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Number of the element Element Description of the element

2 The information area about the 
selected event in the list

The information about the selected event: 
the camera name, the lane name, the 
event name, the date in the DD.MM.YYYY 
format, the time of detecting an event, the 
photo made by the camera when 
detecting an event

3 The photo area of the selected 
event in the list

The photo of the selected event made by 
the camera in the list

4 The Clear button Deletes detected events by the camera 
from the table

5 The Print button Prints a report about the selected Report 
on event (see Viewing and printing the 
event information in the traffic analysis 
monitor window)

The event archive mode from cameras

Description of the interface elements.
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Number of the element Element Description of the element

1 The Period from and to 
fields

The beginning and ending of the period of the 
data receiving, the values of which are set using 
the arrows and a calendar

2 The Filters button Opens the window for selecting filters by the 
detector, by an event, or by the vehicle of this 
detector

3 The Refresh button Refreshes the list of events

4 The data source RR channels from which the statistic data is 
displayed

5 Detected events The table of events detected by cameras

6 The Monitoring button Switches to the event monitoring mode

7 The Clear button Deletes detected events by the camera from the 
table

8 The Print button Prints a report about the selected Report on
event (see Viewing and printing the event 
information in the traffic analysis monitor 
window)
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4.1.2 The program for viewing reports of the traffic analysis monitor
The program window for viewing reports contains the following interface elements:

Description of the program interface elements for viewing reports.

Number of the element Description of the element

1 The main program menu for viewing reports (file operations, 
viewing operations and report navigation, working with 
report, viewing the information about program)

2 The block of elements for operations with the report file 
(printing, opening, saving, exporting a file)

3 The block of elements for operations with a report (displaying 
a content, searching, refreshing, editing)
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Number of the element Description of the element

4 Selects the scale mode and the scale of the report display

5 Zooms in and out a report

6 Selects the report display mode (displaying pages one by one, 
continuous page-by-page display)

7 The block of elements for navigating through a report

8 Cancels the last action or switches to the previous one

9 The field for displaying the created report

4.2 Interface description of the Vehicle Tracer object

4.2.1 The Events monitor
The Events monitor contains the following interface elements.

Description of the interface elements of the Events monitor window.

Element number Description

1 Detector of the LP of the passing vehicle
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Element number Description

2 A frame with a passing vehicle and a caption

3 Recognized LP number and a LP image

4.2.2 The Alarm window
The Alarm window contains the following interface elements.

Description of the interface elements of the Alarm window.

Element number Element Description

1 Frame area with a caption Signed video frame with a moving vehicle

2 Total alarms Number of unprocessed alarm events
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•

•

•

•

Element number Element Description

3 Information area about the captured event

Date/time Date and time when an alarm event was 
recorded

License plate Vehicle license plate number

Control server Recognition channel that captured an alarm

Direction Direction of vehicle movement relative to 
camera

Internal Vehicles DB External database of vehicle license plates

Note. The Internal Vehicles DB field isn't 
displayed if an alarm event was initiated 
manually

State Current state of an alarm event

There can be the following states of an alarm 
event:

Not confirmed—a new event that has 
not yet been confirmed;
Processing...—an alarm event is 
confirmed, but the information has not 
yet been recorded to the database;
Confirmed—an alarm is confirmed and 
recorded to the database (you may not 
notice this state since the event is 
deleted from the Alarm window after a 
successful confirmation);
Error—confirmation isn't recorded to the 
database due to the heavy load on the 
Server. It is necessary to confirm the 
event again

4 Table with a description from 
Internal Vehicles DB

Description from Internal vehicles database

Note. The table with description from Internal 
vehicles database isn't displayed if an alarm 
event was initiated manually
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Element number Element Description

5 Buttons to move through alarm 
events in the list Go to the first alarm event in the list ; go to 

the previous alarm event in the list ; go to 

the next alarm event in the list ; go to the 

last alarm event in the list 

6 Trace If the checkbox is set, when an alarm is 
confirrmed, it disappears from all alarm 
windows in the distributed configuration; when 
an alarm isn't confirmed, it disappears only 
from the current alarm window. 
If the checkbox isn't set, when an alarm is 
confirrmed or isn't confirrmed, it disappears 
only from the current alarm window

7 Confirmed (Information sent) Confirmation of the alarm status of an event. If 
you click this button, an alarm is marked as 
accepted in the Online monitor window. A 
window offering to print the alarm event card is 
also displayed

8 No confirmation Close the alarm window. If you click this button, 
the status of an alarm event isn't changed in the 
Online monitor window. Alarm disappears from 
the Alarm window

4.2.3 The Online monitor
The Online monitor contains the following interface elements.
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Description of the interface elements of the Online monitor.

Element 
number

Element Description

1 Area Information about the last passed vehicle or about an event, selected in 
the identified vehicles protocol or in the alarms protocol

2 Cars Access to the identified vehicles protocol

3 Alarms protocol When an alarm event occur, you can go to the Alarms protocol tab. This 
tab displays the video frame and the number of the most recent alarm 
event
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Element 
number

Element Description

4 Processed
Hide

Hide the processed events in the protocols

5 Show All Enable/disable the pre-configured filters

6 Trace Resume the online update of the displayed vehicle protocol

7 Alarm Alarm initiated by the operator

8 Accept Alarm acceptance

9 Server status Go to the list of errors occurred in the Vehicle Tracer module

10 Database Display of the information from the external database

11 Event table Identified vehicles protocol or the alarms protocol depending on the 
activated tabs—Cars tab or Alarms protocol tab



Auto PSIM 2.0 (english) – Operator's Guide

Description of the Auto PSIM user interface– 95

Element 
number

Element Description

12 Collapse/expand 
button

Collapse/expand the panel with comments and external database

13 Comment Display of the comment to the selected event

14 Print Create the report with data about the selected event

15 Search Open the window for searching in the databases of license plate 
recognizers

16 Video archive Go to the video archive of identified vehicles

17 Filter Go to the filter settings used in protocols

18 Comment Comment to the selected event with specified date and time of the 
comment creation

4.2.4 The Event search in the Recognizers DBs window
The Event search in the Recognizers DBs window contains the following interface elements.
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Description of the interface elements of the Event search in the Recognizers DBs window.



Auto PSIM 2.0 (english) – Operator's Guide

Description of the Auto PSIM user interface– 97

1.
a.
b.

2.
a.

3.
a.
b.

4.
a.

5.
a.

Element 
number

Element Description

1 Main menu The main menu, which you can use to perform the following 
operations:

The File command: 
Print the event search results.
Close the Event search in the Recognizers 
DBs window.

The View command: 
Configure the display of remote servers and 
databases.

The Settings command: 
Configure the display of event search results.
Connect the recognizers databases.

The Servers command: 
Select the servers for searching the events.

The Internal SVDBs command:
Edit the user "Active tracking" database

2 Search type tabs Select the search type: by vehicles or by alarms

3 List of fields for search 
query

Form the search query of the selected search type

4 Reset Clear the search form from the specified search criteria

5 Find Start the processing of the search query

6 Search results table Display of the event search results in the form of a table

7 Navigation panel through 
search results table Go to the first page of the search results ; go to the previous 

page of the search results ; go to the next page of the search 

results ; go to the last page of the search results , 
number of the displayed page from the total number of search 

result pages 

4.2.5 The preview report
The preview report program window contains the following interface elements.
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The preview report interface description is presented in the following table.

Element number Description

1 Main menu for viewing the reports (operations with a file, operations of 
previewing and navigating the report, operation with a report, viewing 
the information about program).
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Element number Description

2 Group of elements for operations with a report file (printing, opening, 
saving, exporting).

3 Group of elements for operations with a report (displaying, content, 
search, update, edit).

4 Selecting the scaling mode and the scale of displaying the report.

5 Zooming the report.

6 Selecting the mode of displaying the report (page-by-page, nonstop 
page-by-page).

7 Group of elements for navigation in the report.

8 Undo or redo the last action.

9 Field for displaying the formed report.
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